
Microsoft Access 2019 cheat sheet

Frequently used shortcuts
Alt or F10  Select the active tab of 

the ribbon and activate KeyTips

Alt + H Open the Home tab

F6 Move the focus to a different 
pane of the window

Ctrl + O or Ctrl + 
F12

Open an existing database

F11 Show or hide the Navigation 
Pane

F4 Show or hide a property sheet

F2 Switch between Edit mode (with 
insertion point displayed) and 
Navigation mode in a datasheet 
or design view

F5 Switch to Form view from form 
Design view

Tab or Shift + Tab Move to the next or previous 
field in a Datasheet view

F5 Go to a specific record in a 
Datasheet view

Ctrl + P Open the Print dialog box from 
Print (for datasheets, forms, and 
reports)

S Open the Page Setup dialog box 
(for forms and reports)

Z Zoom in or out on a part of the 
page

Ctrl + F Open the Find tab in the Find 
and Replace dialog box in the 
Datasheet view or Form view

Ctrl + H Open the Replace tab in the Find 
and Replace dialog box in the 
Datasheet view or Form view

Ctrl + + Add a new record in Datasheet 
view or Form view

F1 Open the Help window

Alt + F4 Exit Access

Navigating the ribbon
There are two ways to navigate the tabs in the ribbon:

To get to the ribbon, press Alt, and then, to move 
between tabs, use the Right Arrow and Left Arrow 

keys.

To go directly to a tab on the ribbon, press one of the 
following KeyTips:

Alt + F Open the File page

Alt + H Open the Home tab

Alt + C Open the Create tab

Alt + X Open the External Data tab

Alt + Y Open the Database Tools tab

Alt + J then B B Open the Fields tab

Alt + J then T T Open the Table tab

Alt + X then 2 2 Open the Add-ins tab, if 
present

Alt + Q and then enter the search term 
to open the Tell me box on the 
ribbon

Ctrl + Left arrow / 
Right arrow

Move between groups on a 
ribbon

Tab or Shift + Tab Move between commands within 
a group

You activate controls in different ways, depending 
upon the type of control.

If the selected command is a button, to activate it, 
press Spacebar or Enter.

If the selected command is a split button (that is, a 
button that opens a menu of additional options), to 
activate it, press Alt+Down Arrow. Tab through the 
options. To select the current option, press Spacebar 
or Enter.

If the selected command is a list (such as the Font 
list), to open the list, press the Down Arrow key. Then, 
to move between items, press the Up Arrow key or 
the Down Arrow key.

If the selected command is a gallery, to select the 
command, press Spacebar or Enter. Then, tab 
through the items.

Here is the ways to move the focus by using the 
keyboard:

Alt or F10 Select the active tab of the 
ribbon and activate KeyTips

Arrow keys Move to a different tab

Tab or Shift + Tab Move the focus to commands on 
the ribbon

Arrow keys Move among the items on the 
ribbon
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Ctrl + F1 Expand or collapse the ribbon

Shift + F10 Display the shortcut menu for the 
selected item

F6 Move the focus to a different 
pane of the window

Tab or Shift + Tab Move to the next or previous 
command on the ribbon

Space or Enter Activate the selected command 
or control on the ribbon

Space or Enter Open the selected menu or 
gallery on the ribbon

Down arrow Open the selected list on the 
ribbon, such as the Font list

Tab Move between items in an open 
menu or gallery

Enter Finish modifying a value in a 
control on the ribbon, and move 
the focus back to the document

Work with database files
Ctrl + N Open a new database

Ctrl + O or Ctrl + 
F12

Open an existing database

Enter Open the selected folder or file

Backspace Open the folder one level above 
the selected folder

Del Delete the selected folder or file

Shift + F10 Display a shortcut menu for a 
selected item such as a folder or 
file

Tab Move forward through options

Shift + Tab Move backward through options

F4 or Alt + I Open the Look in list

Ctrl + S or Shift + 
F12

Save a database object

F12 or Alt + F + S Open the Save As dialog box

Print database information
Ctrl + P Print the current or selected 

object

P or Ctrl + P From Print Preview, open the 
Print dialog box

From Print Preview, open the S

Page Setup dialog box

C or Esc  Cancel Print Preview or 
Layout Preview

Esc From the Backstage, return to 
your database

Navigate in the Access workspace
By default, Access databases display as tabbed 
documents. To switch to windowed documents 
instead, on the File tab, select Options. In the Access 
Options dialog box, select Current Database and, 
under Document Window Options, select Overlapping 
Windows.

F11 Show or hide the Navigation 
Pane

Ctrl + F Go to the Navigation 
PaneSearch box (if the focus is 
already on the Navigation Pane)

F6 or Shift + F6 Switch to the next or previous 
pane in the workspace

Note: You might need to press F6 more than once; if 
pressing F6 doesn't display the task pane you want, 
press Alt to move the focus on the ribbon and then 
press Ctrl+Tab to move to the task pane.

Ctrl + F6 or Ctrl + 
Shift + F6

Switch to the next or previous 
database window

Enter Restore the selected minimized 
window when all windows are 
minimized

Ctrl + F8 Turn on Resize mode for the 
active window when it is not 
maximized (press the arrow keys 
to resize the window, and then, 
to apply the new size, press 
Enter)

Ctrl + W or Ctrl + 
F4

Close the active database 
window

Alt + F11 Switch between the Visual Basic 
Editor and the previous active 
window

Ctrl + F10 Maximize or restore a selected 
window

Working with menus, dialog boxes, wizards, and 
property sheets

Alt or F10  Show KeyTips

Show the program icon menu Alt + Space
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(on the program title bar), also 
known as the control menu

Up arrow / Down 
arrow

With the menu or submenu 
visible, select the previous or 
next command

Left arrow / Right 
arrow

Select the menu to the left or 
right; or, when a submenu is 
visible, switch between the main 
menu and the submenu

Home or End Select the first or last command 
on the menu or submenu

Space or Enter Open the selected menu, or 
perform the action assigned to 
the selected button

Shift + F10 Open a shortcut menu or open a 
drop-down menu for the selected 
gallery item

Page Up or Page 
Down

Scroll up or down in the selected 
gallery list

Ctrl + Home or 
Ctrl + End

Move to the top or bottom of the 
selected gallery list

Alt Close the visible menu and 
submenu at the same time

Esc Close the visible menu; or, with a 
submenu visible, close only the 
submenu

Using dialog boxes
Ctrl + Tab or Ctrl + 
Shift + Tab

Switch to the next or previous 
tab in a dialog box

Tab or Shift + Tab Move to the next or previous 
option or option group

Arrow keys Move between options in the 
selected drop-down list box, or 
move between options in a 
group of options

Space Perform the action assigned to 
the selected button; select or 
clear the check box

First letter of an option in a drop-down list:  Open the 
list if it is closed and move to an option in the list

Alt + [A - Z] Select the option, or select or 
clear the check box by the letter 
underlined in the option name

Alt + Down arrow Open the selected drop-down list 
box

Esc Close the selected drop-down 
list box

Enter Perform the action assigned to 
the default button in the dialog 
box

Esc Cancel the command and close 
the dialog box

Using wizards
Tab Toggle the focus forward 

between controls in the wizard

F6 Toggle the focus between 
sections (header, body, footer) of 
the wizard

Alt + N Move to the next page of the 
wizard

Alt + B Move to the previous page of the 
wizard

Alt + F Complete the wizard

Using property sheets
F4 Show or hide the property sheet

Alt + Enter Display a property sheet in 
Design view

Up arrow / Down 
arrow

Move among choices in the 
control selection drop-down list 
one item at a time

Page Down or 
Page Up

Move among choices in the 
control selection drop-down list 
one page at a time

Tab Move to the property sheet tabs 
from the control selection drop-
down list

Left arrow / Right 
arrow

Move among the property sheet 
tabs with a tab selected, but no 
property selected

Tab With a property already selected, 
move down one property on a 
tab

Shift + Tab With a property selected, move 
up one property on a tab; or if 
already at the top, move to the 
tab

Ctrl + Tab Toggle forward between tabs 
when a property is selected
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Ctrl + Shift + Tab Toggle backward between tabs 
when a property is selected

Editing in a text box
Home Move to the beginning of the 

entry

End Move to the end of the entry

Left arrow / Right 
arrow

Move one character to the left or 
right

Ctrl + Left arrow or 
Ctrl + Right arrow

Move one word to the left or right

Shift + Home Select from the insertion point to 
the beginning of the text entry

Shift + End Select from the insertion point to 
the end of the text entry

Shift + Left arrow Change the selection by one 
character to the left

Shift + Right arrow Change the selection by one 
character to the right

Ctrl + Shift + Left 
arrow

Change the selection by one 
word to the left

Ctrl + Shift + Right 
arrow

Change the selection by one 
word to the right

Using a combo or list box
F4 or Alt + Down 
arrow

Open a combo box

F9 Refresh the contents of a 
Lookup field list box or combo 
box

Down arrow Move down one line

Page Down Move down one page

Up arrow Move up one line

Tab Exit the combo box or list box

Ctrl + E Open the Edit List Items dialog 
box

Note: In order to use the Ctrl+E keyboard shortcut for 
opening the Edit List Items dialog box, you must have 
an Office 365 subscription. Currently this shortcut is 
only available to Insiders at this time.

Edit and navigate the Object list
F2 Rename a selected object

Note: F2 works only when the object is closed.

Down arrow Move down one line

Page Down Move down one window

End Move to the last object

Up arrow Move up one line

Page Up Move up one window

Navigating and opening objects
Enter Open the selected table or query 

in Datasheet view

Enter Open the selected form or report

Enter Run the selected macro

Ctrl + Enter Open the selected table, query, 
form, report, macro, or module in 
Design view

Ctrl + G Display the Immediate window in 
the Visual Basic Editor

Working in a Design, Layout, or 
Datasheet view

F2 Switch between Edit mode (with 
insertion point displayed) and 
Navigation mode in a datasheet

Esc Exit Navigation mode and return 
to Edit mode in a form or report

F4 or Alt + Enter Switch to the property sheet 
(Design view and Layout view in 
forms and reports)

F5 Switch to Form view from form 
Design view

F6 Switch between the upper and 
lower portions of a window 
(Design view of queries, macros, 
and the Advanced Filter/Sort 
window)

F6 Cycle through the field grid, 
property sheet, field properties, 
the Navigation Pane, Quick 
Access Toolbar, and KeyTips on 
the ribbon (Design view of 
tables)

F7 Open the Choose Builder dialog 
box from a selected control on a 
form or report (Design view only)
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F7 Open the Visual Basic Editor 
from a selected property in the 
property sheet for a form or 
report

Alt + F11 Switch from the Visual Basic 
Editor back to form or report 
Design view

Ctrl + Right arrow 
or Ctrl + ,

Toggle forward between views 
when in a table, query, form, or 
report

Note: If additional views are available, successive 
keystrokes move the focus to the next available view.

Ctrl + Left arrow or 
Ctrl + .

Toggle backward between views 
when in a table, query, form, or 
report

Note: Ctrl+Period (.) does not work under all 
conditions with all objects.

Datasheet view: Navigate between 
fields and records

Tab or Right arrow Move to the next field

End Move to the last field in the 
current record

Shift + Tab or Left 
arrow

Move to the previous field

Home Move to the first field in the 
current record

Down arrow Move to the current field in the 
next record

Ctrl + Down arrow Move to the current field in the 
last record

Ctrl + End Move to the last field in the last 
record

Up arrow Move to the current field in the 
previous record

Ctrl + Up arrow Move to the current field in the 
first record

Ctrl + Home Move to the first field in the first 
record

F5 (then, in the record number box, 
type the record number and 
press Enter) Go to a specific 
record

Datasheet view: Navigate to 
another screen of data

Page Down Move up one screen

Page Up Move down one screen

Ctrl + Page Down Move right one screen

Ctrl + Page Up Move left one screen

Datasheet view: Selecting and 
moving a column

Ctrl + Space Select the current column or 
cancel the column selection, in 
Navigation mode only

Shift + Right arrow Extend the selection one column 
to the right, if the current column 
is selected

Shift + Left arrow Extend the selection one column 
to the left, if the current column 
is selected

Ctrl + Shift + F8 
then Left arrow / 
Right arrow

ht Turn on Move mode

Datasheet view: Working with 
subdatasheets

Tab Enter the subdatasheet from the 
last field of the previous record in 
the datasheet

Shift + Tab Enter the subdatasheet from the 
first field of the following record 
in the datasheet

Ctrl + Tab Exit the subdatasheet and move 
to the first field of the next record 
in the datasheet

Ctrl + Shift + Tab Exit the subdatasheet and move 
to the last field of the previous 
record in the datasheet

Tab From the last field in the 
subdatasheet enter the next field 
in the datasheet

Down arrow From the datasheet, bypass the 
subdatasheet and move to the 
next record in the datasheet

From the datasheet, bypass the Up arrow
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subdatasheet and move to the 
previous record in the datasheet

Alt + F5 Go to a specific record in a 
subdatasheet

Note: This moves the focus from the subdatasheet to 
the record number box.

Ctrl + Shift + 
Down arrow

Move from the datasheet to the 
record's subdatasheet

Ctrl + Shift + Up 
arrow

Collapse the subdatasheet

Note: To navigate between fields and records in a 
subdatasheet, use the same keyboard shortcuts you 
use in Datasheet view.

Design view: Navigating
F2 Switch between Edit mode (with 

insertion point displayed) and 
Navigation mode

F4 or Alt + Enter Open or close the property sheet

F5 Switch to Form view from form 
Design view

F6 Switch between the upper and 
lower portions of a window 
(Design view of queries, macros, 
and the Advanced Filter/Sort 
window)

Note: Use F6 when the Tab key does not take you to 
the section of the screen you want.

F6 Toggle forward between the 
design pane, properties, 
Navigation Pane, ribbon, and 
Zoom controls (Design view of 
tables, forms, and reports)

F7 Open the Visual Basic Editor 
from a selected property in the 
property sheet for a form or 
report

Alt + F8 Invoke the Field List pane in a 
form, or report (if the Field List 
pane is already open, the focus 
moves to the Field List pane)

Shift + F7 When you have a code module 
open, switch from the Visual 
Basic Editor to form or report 
Design view

Switch from a control's property Shift + F7

sheet in form or report Design 
view to the design surface 
without changing the control 
focus

Ctrl + C Copy the selected control to the 
Clipboard

Ctrl + X Cut the selected control and 
copy it to the Clipboard

Ctrl + V Paste the contents of the 
Clipboard in the upper-left corner 
of the selected section

Right arrow Move the selected control to the 
right by a pixel along the page's 
grid

Left arrow Move the selected control to the 
left by a pixel along the page's 
grid

Up arrow Move the selected control up by 
a pixel along the page's grid

Note: For controls in a stacked layout, this switches 
the position of the selected control with the control 
directly above it, unless it is already the uppermost 
control in the layout.

Down arrow Move the selected control down 
by a pixel along the page's grid

Note: For controls in a stacked layout, this switches 
the position of the selected control with the control 
directly below it, unless it is already the lowermost 
control in the layout.

Ctrl + Right arrow Move the selected control to the 
right by a pixel (irrespective of 
the page's grid)

Ctrl + Left arrow Move the selected control to the 
left by a pixel (irrespective of the 
page's grid)

Ctrl + Up arrow Move the selected control up by 
a pixel (irrespective of the page's 
grid)

Note: For controls in a stacked layout, this switches 
the position of the selected control with the control 
directly above it, unless it is already the uppermost 
control in the layout.

Ctrl + Down arrow Move the selected control down 
by a pixel (irrespective of the 
page's grid)

Note: For controls in a stacked layout, this switches 
the position of the selected control with the control 
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directly below it, unless it is already the lowermost 
control in the layout.

Shift + Right arrow Increase the width of the 
selected control (to the right) by 
a pixel

Note: For controls in a stacked layout, this increases 
the width of the whole layout.

Shift + Left arrow Decrease the width of the 
selected control (to the left) by a 
pixel

Note: For controls in a stacked layout, this decreases 
the width of the whole layout.

Shift + Up arrow Decrease the height of the 
selected control (from the 
bottom) by a pixel

Shift + Down 
arrow

Increase the height of the 
selected control (from the 
bottom) by a pixel

Design view: Editing using controls 
in form and report

Ctrl + C Copy the selected control to the 
Clipboard

Ctrl + X Cut the selected control and 
copy it to the Clipboard

Ctrl + V Paste the contents of the 
Clipboard in the upper-left corner 
of the selected section

Right arrow Move the selected control to the 
right (except a control that is part 
of a layout)

Ctrl + Right arrow (Move in smaller increments) 
Move the selected control to the 
right (except a control that is part 
of a layout)

Left arrow Move the selected control to the 
left (except a control that is part 
of a layout)

Ctrl + Left arrow (Move in smaller increments) 
 Move the selected control to the 
left (except a control that is part 
of a layout)

Up arrow Move the selected control up 
(except a control that is part of a 
layout)

Ctrl + Up arrow (Move in smaller increments) 
 Move the selected control up 
(except a control that is part of a 
layout)

Down arrow Move the selected control down 
(except a control that is part of a 
layout)

Ctrl + Down arrow (Move in smaller increments) 
Move the selected control down 
(except a control that is part of a 
layout)

Shift + Down 
arrow

Increase the height of the 
selected control

Note: If used with a control that is in a layout, the 
entire row of the layout is resized.

Shift + Right arrow Increase the width of the 
selected control

Note: If used with a control that is in a layout, the 
entire column of the layout is resized.

Shift + Up arrow Reduce the height of the 
selected control

Note: If used with a control that is in a layout, the 
entire row of the layout is resized.

Shift + Left arrow Reduce the width of the selected 
control

Note: If used with a control that is in a layout, the 
entire column of the layout is resized.

Form view: Navigate between fields 
and records

Tab Move to the next field

Shift + Tab Move to the previous field

End Move to the last control on the 
form and remain in the current 
record

Ctrl + End Move to the last control on the 
form and set focus in the last 
record

Home Move to the first control on the 
form and remain in the current 
record

Ctrl + Home Move to the first control on the 
form and set focus in the first 
record

Move to the current field in the Ctrl + Page Down
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next record

Ctrl + Page Up Move to the current field in the 
previous record

F5 Go to a specific record

Form view: Navigate in forms with 
more than one page

Page Down Move down one page; at the end 
of the record, moves to the 
equivalent page on the next 
record

Page Up Move up one page; at the end of 
the record, moves to the 
equivalent page on the previous 
record

Form view: Navigate between a 
main form and a subform

Tab Enter the subform from the 
preceding field in the main form

Shift + Tab Enter the subform from the 
following field in the main form

Ctrl + Tab Exit the subform and move to the 
next field in the master form or 
next record

Ctrl + Shift + Tab Exit the subform and move to the 
previous field in the main form or 
previous record

Form view: Navigate in Print 
Preview and Layout Preview

Ctrl + P Open the Print dialog box from 
Print (for datasheets, forms, and 
reports)

S Open the Page Setup dialog box 
(for forms and reports)

Z Zoom in or out on a part of the 
page

C or Esc Cancel Print Preview or Layout 
Preview

Down arrow Scroll down in small increments

Page Down Scroll down one full screen

Ctrl + Down arrow Move to the bottom of the page

Up arrow Scroll up in small increments

Page Up Scroll up one full screen

Ctrl + Up arrow Move to the top of the page

Right arrow Scroll to the right in small 
increments

End Move to the right edge of the 
page

Ctrl + End Move to the lower-right corner of 
the page

Left arrow Scroll to the left in small 
increments

Home Move to the left edge of the page

Ctrl + Home Move to the upper-left corner of 
the page

Alt + F5 Move to the page number box

Working with panes: Using diagram 
pane

Tab or Shift + Tab Move among tables, views, and 
functions (and join lines, if 
available)

Arrow keys Move between columns in a 
table, view, or function

Space or + Choose the selected data 
column for output

Space or - Remove the selected data 
column from the query output

Del Remove the selected table, view, 
or function, or join line from the 
query

Note: If multiple items are selected, pressing 
Spacebar affects all selected items. Select multiple 
items by holding down Shift while selecting them. 
Toggle the selected state of a single item by holding 
down Ctrl while selecting it.

Working with panes: Using grid 
pane

Arrow keys or Tab 
or Shift + Tab

Move among cells

Ctrl + Down arrow Move to the last row in the 
current column

Move to the first row in the Ctrl + Up arrow
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current column

Ctrl + Home Move to the upper-left cell in the 
visible portion of grid

Ctrl + End Move to the bottom right cell

Up arrow or Down 
arrow

Move in a drop-down list

Ctrl + Space Select an entire grid column

F2 Toggle between Edit mode and 
cell selection mode

Ctrl + C Copy selected text in cell to the 
Clipboard (in Edit mode)

Ctrl + X Cut selected text in cell and 
place it on the Clipboard (in Edit 
mode)

Ctrl + V Paste text from the Clipboard (in 
Edit mode)

Insert Toggle between insert and 
overtype mode while editing in a 
cell

Space Toggle the check box in the 
Output column

Note: If multiple items are selected, pressing this key 
affects all selected items.

Del Clear the selected contents of a 
cell

Del Clear all values for a selected 
grid column

Working with panes: Using SQL 
pane

You can use the standard Windows editing keys when 
working in the SQL pane. For example, you can use 
Ctrl+ Arrow keys to move between words, and the 
Cut, Copy, and Paste commands on the Home tab 
work as they normally do.

Working with panes: Using Field 
List pane with a form or report in 
Design view or Layout view

Alt + F8 Show or hide the Field List pane

Enter Add the selected field to the form 
or report detail section

Up arrow / Down Move up or down the Field List 

arrow pane

Tab Move between the upper and 
lower panes of the Field List

Select a field or record
Tab Select the next field

F2 Switch between Edit mode (with 
insertion point displayed) and 
Navigation mode in a datasheet

Esc Exit Navigation mode in a form 
or report

Shift + Space Switch between selecting the 
current record and the first field 
of the current record, in 
Navigation mode

Shift + Up arrow Extend the selection to the 
previous record, if the current 
record is selected

Select in a field
Shift + Right arrow Change the size of the selection 

by one character to the right

Ctrl + Shift + Right 
arrow

Change the size of the selection 
by one word to the right

Shift + Left arrow Change the size of the selection 
by one character to the left

Ctrl + Shift + Left 
arrow

Change the size of the selection 
by one word to the left

Extend a selection
F8 Turn on Extend mode 

(repeatedly pressing F8 extends 
the selection to the word, the 
field, the record, and all records)

Note: In Datasheet view, Extended Selection appears 
in the lower-right corner of the window

Left arrow / Right 
arrow

Extend a selection to adjacent 
fields in the same row in 
Datasheet view

Up arrow / Down 
arrow

Extend a selection to adjacent 
rows in Datasheet view

Shift + F8 Undo the previous extension

Esc Cancel Extend mode
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Find and replace text or data
Ctrl + F Open the Find tab in the Find 

and Replace dialog box 
(Datasheet view and Form view 
only)

Ctrl + H Open the Replace tab in the Find 
and Replace dialog box 
(Datasheet view and Form view 
only)

Shift + F4 Find the next occurrence of the 
text specified in the Find and 
Replace dialog box when the 
dialog box is closed (Datasheet 
view and Form view only)

Edit text or data: Move the insertion 
point in a field

Note: If the insertion point is not visible, press F2 to 
display it.

Right arrow Move the insertion point one 
character to the right

Ctrl + Right arrow Move the insertion point one 
word to the right

Left arrow Move the insertion point one 
character to the left

Ctrl + Left arrow Move the insertion point one 
word to the left

End Move the insertion point to the 
end of the field, in single-line 
fields; or move it to the end of 
the line in multi-line fields

Ctrl + End Move the insertion point to the 
end of the field, in multi-line 
fields

Home Move the insertion point to the 
beginning of the field, in single-
line fields; or move it to the 
beginning of the line in multi-line 
fields

Ctrl + Home Move the insertion point to the 
beginning of the field, in multi-
line fields

Edit text or data: Copy, move, or 

delete text
Ctrl + C Copy the selection to the 

Clipboard

Ctrl + X Cut the selection and copy it to 
the Clipboard

Ctrl + V Paste the contents of the 
Clipboard at the insertion point

Backspace Delete the selection or the 
character to the left of the 
insertion point

Del Delete the selection or the 
character to the right of the 
insertion point

Ctrl + Del Delete all characters to the right 
of the insertion point

Edit text or data: Undo changes
Ctrl + Z or Alt + 
Backspace

Undo typing

Esc Undo changes in the current field 
or current record (if both the 
current field and current record 
have been changed, press Esc 
twice to undo changes, first in 
the current field and then in the 
current record)

Edit text or data: Enter data in a 
Datasheet or Form view

Ctrl + ; Insert the current date

Ctrl + Shift + : Insert the current time

Ctrl + Alt + Space Insert the default value for a field

Ctrl + ' Insert the value from the same 
field in the previous record

Ctrl + + Add a new record

Ctrl + - In a datasheet, delete the current 
record

Shift + Enter Save changes to the current 
record

Space Switch between the values in a 
check box or option button

Ctrl + Enter Insert a new line in a Short Text 
or Long Text field
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Edit text or data: Refresh fields with 
current data

F9 Recalculate the fields in the 
window

Shift + F9 Requery the underlying tables; in 
a subform, this requeries the 
underlying table only for the 
subform

F9 Refresh the contents of a 
Lookup field list box or combo 
box

Navigate in tables and cells: Work 
and move around in tables

Tab Move to the next cell

Shift + Tab Move to the preceding cell

Down arrow Move to the next row

Up arrow Move to the preceding row

Ctrl + Tab Insert a tab in a cell

Enter Start a new paragraph

Tab (at the end of the last row) Add a 
new row at the bottom of the 
table

Navigate in tables and cells: Move 
around in tables or cells

Left arrow Move one character to the left

Right arrow Move one character to the right

Up arrow Move up one line

Down arrow Move down one line

Ctrl + Left arrow Move one word to the left

Ctrl + Right arrow Move one word to the right

End Move to the end of a line

Home Move to the beginning of a line

Ctrl + Up arrow Move up one paragraph

Ctrl + Down arrow Move down one paragraph

Ctrl + End Move to the end of a text box

Ctrl + Home Move to the beginning of a text 
box

Shift + F4 Repeat the last Find action

Get help with Access
F1 Open the Help window

Alt + Home Go back to Access Help Home

Tab Select the next item in the Help 
window

Shift + Tab Select the previous item in the 
Help window

Enter Perform the action for the 
selected item

Enter In the AccessHelp topics list, 
expand or collapse the selected 
item

Tab Select the next hidden text or 
hyperlink, including Show All or 
Hide All at the top of a topic

Shift + Tab Select the previous hidden text 
or hyperlink

Enter Perform the action for the 
selected Show All, Hide All, 
hidden text, or hyperlink

Alt + Left arrow or 
Backspace

Move back to the previous Help 
topic (Back button)

Alt + Right arrow Move forward to the next Help 
topic (Forward button)

Up arrow / Down 
arrow

Scroll small amounts up or down 
within the currently displayed 
Help topic

Page Up or Page 
Down

Scroll larger amounts up or 
down, respectively  within the 
currently displayed Help topic

Esc Stop the last action (Stop button)

F5 Refresh the window (Refresh 
button)

Ctrl + P Print the current Help topic (if the 
cursor is not in the current Help 
topic, press F6, and then press 
Ctrl+P)

F6 then Enter er Open the list of choices and 
change the connection state

F6 Switch among areas in the Help 
window, such as the toolbar and 
the Search list

Up arrow / Down 
arrow

In a Table of Contents in tree 
view, select the previous or next 
item, respectively
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Enter In a Table of Contents in tree 
view, expand or collapse the 
selected item

Miscellaneous keyboard shortcuts
F2 Display the complete hyperlink 

address (URL) for a selected 
hyperlink

F7 Check spelling

Shift + F2 Open the Zoom box to 
conveniently enter expressions 
and other text in small input 
areas

Ctrl + F2 Invoke a Builder

Print Screen Copy a screenshot of the entire 
screen to the Clipboard

Alt + Print Screen Copy a screenshot of the current 
window to the Clipboard

Ctrl + Down arrow Display the full set of commands 
on the task pane menu

Ctrl + Page Up / 
Down

Move between fields vertically

Ctrl + 2 Copy the value from above row

Alt + F4 Exit Access
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